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Welcome to the latest edition of my monthly newsletter. This is the July, 2006, edition.

The goal of this newsletter is to provide information helpful to the professional user of Final 
Cut Pro. This newsletter publishes each month. Past issues are not archived. However, key 
articles are posted on my website for your reference. All software references are to Final Cut 
Studio unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. We now have over 110 
tutorials to help you get the most out of Final Cut!
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Edit Well - The Rich Media Newsletter for Final Cut Studio - Premieres!

After months of planning and just plain hard work, Edit Well is released! The first issue is FREE and yours 
for the downloading. Get your free copy at: www.peachpit.com/editwell.

http://www.larryjordan.biz/index.html
http://www.larryjordan.biz/
http://www.peachpit.com/editwell


Note: Edit Well is only available via download. If you signed up for the free issue, you will 
need to go get it, it is NOT sent to you. The files are too big to email.

While I have the pleasure of being the editor, I also need to thank Nancy Ruenzel, president of Peachpit 
Press, and Jennifer Bortel, Associate Editorial Director at InformIT, for all their efforts in making this 
possible. We currently have a team of ten people working on each issue.

Here's some inside scoop on future subjects: The July issue has Graeme Nattress starting a three-part 
series on creating your own filters using FX Script, Alexis Van Hurkman (he wrote Apple's textbook on 
color correction) starting a three-part series on color correction, as well as articles from Noah Kadner on 
setting up a workflow for the Panasonic P2 camera, Mark Spencer finishing his detailed look at 3rd-party 
plug-ins and me, providing a tutorial on how to do a simple mix in Soundtrack Pro.

In the next couple of months, we have articles planned from Damian Allen on Motion, Mary Plummer on 
Soundtrack Pro, Bruce Nazarian on DVD Studio Pro, Tom Wolsky on Final Cut, Philip Hodgetts on 
video podcasting and many, many more.

All-in-all, it's incredibly cool and very exciting. Subscriptions are just $59.99 per year and the first issue is 
free. Treat yourself to the first issue and see for yourself. There's an on-line survey in it. Let me know what 
you think. 

Click here to download your free copy: http://www.peachpit.com/editwell.

The next issue is scheduled for release the last week in July. 

[ Go to top ] 

Commentary: In Search of a Back-Up Strategy

Philip Fass started me thinking about this again when he wrote:

Here's a suggestion for the next newsletter: would you comment on the current viability of 
data tape as a backup/archiving medium? On message boards, some people say it's 
outdated and recommend hard drives until Blu-Ray becomes affordable. Others think it's an 
affordable, proven technology that's good for people shooting tapeless. What do you think?

I'm trying to decide now, because I've built into a contract the option of recutting a video at a 
later date. So the material has to be kept safe.

Larry replies: Philip, I am so NOT a fan of archiving on hard disk I can't see straight. The camera industry is 
not doing any of us a service by it's headlong rush to tapeless acquisition without first thinking through how 
we are going to archive all this newly-shot media.

Last April at NAB, I felt like I was watching a number of camera manufacturers jump off the cliff of tapeless 
acquisition -- hoping that someone would invent an archive parachute before they smashed on the rocks 
below. As of now, I haven't seen anything I like.

http://www.peachpit.com/editwell


The whole point of archiving is to be able to play something back at an undetermined point in the future. 
Not just saving it a for a week, or a month, or even a year, but five, ten, twenty years into the future.

At this point we have four options for archiving:

●     Video tape
●     Data tape
●     Hard disks
●     Optical discs

Let's briefly look at each of these.

Video tape

Where possible, this is your best option. Ideally, you should archive your camera master tapes.

●     The life-span of video tape is known -- 20 - 35 years when properly stored.
●     Equipment exists today that can play tapes from 30 years ago
●     The storage media is cheap
●     Interfaces are standard

Here's an article that talks about the life-span of video tape: www.larryjordan.biz/articles/lj_videotape.html. 

My first recommendation is to always use your camera master tapes for archiving. 

Data tape

DLT systems have been around for a long-time. Probably the best system is from Quantum (www.quantum.
com) but it isn't cheap -- about $8,000. Still, the IT departments at major corporations have been using DLT 
for a long time. There's an established market, standards, equipment, and media. All good things that you 
want in an archiving solution.

Quantum has an interesting Mac-based solution -- called the SDLT 600A -- that you can read about here: 
http://www.quantum.com/Products/TapeDrives/DLT/SDLT600/Index.aspx

Hard Disks

Here's my problem with archiving on hard disks -- it's your garage. Follow my reasoning.

●     Think of your garage.
●     Think of all the computer equipment you have in your garage.
●     Think of all the computer equipment you have in your garage that's more than 5 years old.
●     Think of all the computer equipment you have in your garage that's more than 5 years old that you 

can still connect to your computer.

Right! NONE of it. That's because the technology industry builds equipment to be out-dated in about four 
years. They change a cable. They change a connector. They change a protocol. The device is too slow. 
Too small. Whatever. It doesn't work.

http://www.larryjordan.biz/articles/lj_videotape.html
http://www.quantum.com/
http://www.quantum.com/
http://www.quantum.com/Products/TapeDrives/DLT/SDLT600/Index.aspx


Where would we be today if Gone with the Wind, or Casablanca, were stored on hard disks? Hard disks 
are essential for editing. They are great for short-term storage. They are miserable for archiving.

Optical discs

Just to make this discussion interesting, we don't have a single optical disk format, we have five flavors to 
consider:

●     CD
●     4.3 GB DVD (single-layer)
●     8.6 GB DVD (dual-layer)
●     HD-DVD vs. Blu-Ray DVD

Again, let's look at each of these. 

CD

These are fine for short pieces, provided you buy media from a brand-name vendor, burn it at a reasonable 
speed, say 16x, and store it like a fine photograph. Here's an article that talks about life-span of optical 
media: http://www.larryjordan.biz/articles/lj_dvd_life.html

Blank media vendors that I currently like include: Apple, Verbatim, and MAM-A. Always buy premium 
quality mediaif you plan to archive for more than a year. Almost any brand is fine for storage less than a 
year.

The problem is that CDs only hold about 700 MB of data. This works out to about 3 minutes of DV video, or 
26 seconds of DigiBeta. 

You can't play from the disc, it's too slow, but you can save your final output to the disc -- if it fits.

4.3 GB single-layer DVD

These are fine for archiving final output, again, provided you buy from a brand-name vendor, burn at a 
reasonable speed, say 16x, and store it like a fine photograph. 

Blank media vendors that I currently like include: Apple, Verbatim, and MAM-A. Always buy premium 
quality if you plan to archive for more than a year. Almost any brand is fine for storage less than a year.

Again, the problem is that these DVDs only hold about 20 minutes of HDV or DV video in it's 
uncompressed, high-quality, most-editable state. If you are working with DigiBeta, your total storage is two-
and-half-minutes. Again, fine for storing final output, but not good for storing dailies or original files.

Rimage told me at NAB they would have a Macintosh-based backup solution out this summer. I was just 
on their website and couldn't find it. However, you can learn more here: http://www.rimage.com/home.html.

8.6 dual-layer DVD

The problem with this latest version of DVD burners is that machine-to-machine compatibility is still elusive. 
You can play the disc back on the system that created it, but getting it to play back on another system is 
very hit-or-miss.

http://www.larryjordan.biz/articles/lj_dvd_life.html
http://www.rimage.com/home.html+


Hit-or-miss are not words I like to hear when I am archiving something.

These burners will be short-term solutions as the mess between HD-DVD and Blu-Ray plays itself out.

HD-DVD & Blu-Ray DVDs

Folks, I'm sorry. If someone sat down to plan a screwed-up product launch, they could not have done a 
better job than what we are witnessing between HD-DVD and Blu-Ray.

We have two incompatible formats, requiring two incompatible players, using two incompatible replication 
systems, all with delayed product ship dates. Half of Hollywood supports one format, half the other. Half 
the computer manufacturers support one, half the other and half are holding out for "something better."

This is not an archive system, this is a soap-opera.

In two years, maybe, things will stabilize to the point where serious discussions can occur regarding what 
works and what doesn't. 

In the meantime, NEVER trust precious masters to a generation one product. Experiment -- yes. Test -- 
yes. Argue, debate, demand better -- all yes. Archive -- not on your life.

My Recommendations

First, if possible, use your video-tape camera masters as your archive.

Second, if that isn't possible, and you have the money, DLT is a proven technology. It isn't sexy. It isn't fast. 
It isn't cheap. But it works, it has worked and it will continue to work - because the broader computer 
industry will continue to drive it. Which means we can piggy back on it for a while.

Third, if DLT is too expensive, and you don't have camera masters, hard disks are your only option. 
However, treat them like gold and assume that drives die. Don't put all your eggs in one basket.

But don't think of it as archiving -- think of it as treading water.

[ Go to top ] 

Two Tips from a BBC Editor

John Ramsden, of the BBC, provided the following two techniques:

We edit a half hour programme for BBC1 each week. There are 3 FCP machines used for 
this. I am also doing some FCP training for the BBC, where I'm also a staff editor.

Here are a couple of things I found useful:



Trick 1 - Switching a PAL video to 16:9

Here in the UK we have DV PAL anamorphic, FCP handles this OK although imported 
material has to have the anamorphic tick put back on. Exports also loose their anamorphic 
property. Here is one fix for a file exported to the desktop as a QuickTime movie using 
current settings, and with self contained not ticked (unchecked). This is the format we use 
when exporting a file to make a DVD.

To make the file wide-screen, right+click (or control+click) the file, choose ‘Open With’ 
‘Quicktime Player’. When the file is open, click the ‘Windows’ menu, and choose ‘Show 
Movie Properties’. In the new window click ‘Video Track’ then ‘Visual Settings’. Remove the 
tick from ‘Preserve Aspect Ratio’ then change the first box in ‘Current size’ from 720 to 1024 
and press return. Put the tick back on ‘Preserve Aspect Ratio’ then from ‘File’ menu, ‘Save’.

Trick 2 - Creating Burned-in Timecode

The next is for creating burnt-in timecode. Back when we had Lightworks we could play out 
with burnt-in timecode, and we could display both source and timeline timecodes at the 
same time. The Avids that replaced Lightworks couldn't do any burn-in at all (unless you 
played through a DigiBeta or DVCam) FCP can, but it has taken me a while to get both 
timecodes on the output.

There are timecode readers and generators in Effects > Video filters > Video. The reader 
reads source timecode and can be dropped on the viewer or timeline, the TCR part can be 
modified (for example, Cam 1). The timecode generator will generate timecode from zero or 
a preset start time (for example, 10:00:00:00). The most useful way to use this is on the 
timeline. Edit ‘Slug’ on a spare video track above the whole timeline, drop timecode 
generator on it, change start time if necessary, apply luminance key to ‘Slug’ and change to 
key out darker. You can change the colour of the box the timecode is on, and see it, so long 
as it isn’t completely black.

Larry replies: John, these are two good techniques. But you don't need the slug.



If you need to output a single long clip, apply both timecode filters -- Effects > Video Filters > Video > 
Timecode Generator and Effects > Video Filters > Video > Timecode Reader -- to the same clip, then 
change the position of one of the filter. The image above illustrates this.



This is what the results look like in the Canvas.

If you need to output a sequence, create a nest -- Sequence > Nest Items -- and apply the filters to the 
nest. The benefit of applying the filters directly is that this significantly decreases your rendering and 
exporting time.

Also, for the record, the image sizes for video are:

PAL 4:3 720 x 576
PAL 16:9 720 x 576 when Anamorphic is checked
PAL 16:9 1024 x 576 To convert in Quicktime when anamorphic is not checked

NTSC 4:3 720 x 480
NTSC 16:9 720 x 480 when Anamorphic checked
NTSC 16:9 834 x 480 To convert in Quicktime when anamorphic is not checked

[ Go to top ] 

Larry's Troubleshooting Your Final Cut System DVD Now Available

My latest training DVD from Lynda.com ships next week: Optimizing and Troubleshooting your Final Cut 
System.



If you've EVER been frustrated trying to get Final Cut to work, this DVD is 
designed to answer your questions. Plus, this shows you how to optimize your system 
to get more out of it.

Ever better, for a limited time, we are combining a second title with this DVD: How to 
Round-trip Files in Final Cut Studio. Both titles for one GREAT price: $49.99.

This DVD should be part of your standard tool-kit as something to consult when 
things go wrong. Click here to read a one-page PDF of the Table of Contents.

This DVD ships the week of July 10 - click here to order: www.larryjordan.biz/store/index.html

[ Go to top ] 

In Search of FCP Rescue

Michael Horton, Head Cutter of the L.A. Final Cut Pro User Group, was the first of many to point out that 
Anders Holck's excellent utility -- FCP Rescue -- can be downloaded, free, from the LAFCPUG web site. If 
you don't already use this utility, now is an excellent time to give it a try.

Download it from: http://www.lafcpug.org.

Better Than FCP Rescue

Ben Balser, an Apple-Certified Trainer, writes:

I also used to host both v.4 and v.5 of FCP Rescue on my own web site for my own students 
to download. But I just found something better than FCP Rescue. It's called FCP 
Preferences Attic and is a free beta.

I and some of my students and colleagues have been using it for awhile now and love it! It 
backs up everything, not just preferences. Layouts and Plugins, too! You may want to check 
this out! FCP trainer Brian Summa turned me on to this.

Update Larry replies: Ben, the website you provided is no longer active. However, Fiver Löcker sent me 
an updated URL for this utility: www.chesa.com/pro/. Remember, it is still in beta. 

[ Go to top ] 

Thoughts on OS and FCP Versions

In providing on-going support to a number of my clients, I keep running into issues where FCP and a 
particular OS version do not particularly like each other.

http://www.larryjordan.biz/store/index.html
http://www.larryjordan.biz/assets/store/Trouble_TOC.pdf
http://www.larryjordan.biz/store/index.html
http://www.lafcpug.org/store_soft_hard.html#anchor3791410
http://www.chesa.com/pro/


For this reason, I tend to recommend you avoid upgrading immediately when a new version of the OS or 
Final Cut is announced until we see whether it is stable or not.

My general rule is: if your system is working fine, don't upgrade. For instance, my main editing system is 
running FCP 5.0.4 and OS 10.3.9. Except...

I just got a new gig compressing about 1,500 videos, so, last week I bought an iMac/Intel because I 
needed another editing/compression system.I installed OS 10.4.7 (the latest version) and Final Cut Studio 
5.1.1. And I must say, I am very impressed with the speed of the iMac and the stability of FCP and the OS.

If you buy an Intel/Mac, you must upgrade to FCS 5.1. Based on my experience, the upgrade -- especially 
if you are doing work needing Compressor -- is very worthwhile.

Here's a website I use a lot to get updates on software and hardware stability: www.macintouch.com. 

Keep in mind that I am not a testing laboratory. Your results may vary.

[ Go to top ] 

Seeking The Life-Span of Video Tape 

Swami Yatidharmananda writes: 

I am Swami Yatidharmananda From The Divine Life Society, Sivananda Ashram, India. It is 
a non-profitable, charitable and spiritual organisation. I came across your articles while 
searching for information about the life of video tapes. I need your advise.

I am here in this spiritual organisation. We have thousands of VHS tapes few hundreds of 
Hi8 tapes containing very amazing content since 1980s. But editing them takes a lot of time. 
So I am of the opinion that as it will take a lot of time to capture edit and finally put them on 
DVDs, we should transfer them onto DV tapes using the Sony DSR 11 DV recorder directly 
first so that the Tapes can be saved for the next 20 years. After editing I wish to make a 
DVD master and also print to tape using the Master DV tapes made by panasonic. I also feel 
that the MOV files also should be stored in some other format so that future formats can be 
handled like HD DVd or Blue ray. If I am only making DVDs, then the future rolling of the 
Data may not be possible to the other medias.

Is it the right understanding? Will it be the right way? Because many people in my institution 
do not agree. They are saying tape do not last longer. We should only store in DVDs. So I 
started looking up in the internet and found your articles. You being in the field and an 
expert, your opinion regarding this will be a great help. could you please give us your opinion 
regarding this. We have a Mac G5 and FCP. Also we have Sony DSR 11 DV Recorder.

Your advise is much appreciated in advance. Thanking you.

Larry replies: The issue of the life-span of video tapes versus optical media is complex.

http://www.macintouch.com/


SOME optical media will last longer than tape -- however, the majority of DVDs last about the same as 
tape and some last only a year or two. Product brand has a lot to do with it, as do a large number of 
technical factors.

My recommendation is to take your VHS and Hi-8 tapes and transfer them through a Time-Base Corrector 
(such as the DataVideo TBC-1000) onto DV tape, using the DVCAM format on your Sony DSR-11 
recorder. The Time-Base Corrector cleans up problems with your VHS video, such as chroma smear, drop-
outs, tearing and other bad things. (DVCAM is better than MiniDV for the work you are doing.)

Buy "Mastering" quality video tape - such as Sony or Panasonic. Once you pick a brand of tape, stay with 
it; don't change brands. Changing brands can adversely affect your recordings, as the tape wears the video 
tape deck heads in unique ways. Changing tape brands alters the wear pattern, decreasing the quality of 
your recordings.

Once you have made your DV tape dubs, store the tapes in a relatively cool, dry, dark place -- avoiding 
extremes of dust, heat and light. Given reasonable storage, a good quality video tape should last 20-25 
years, easily. This would allow you the luxury of waiting for optical storage media to stabilize in price, 
format and quality, so that the next time these tapes need to be dubbed, they can be copied to optical 
media.

However, now is NOT the time to do so, as my article earlier made clear. 

Finally, because DV tape has a higher video quality than VHS tape, you won't have a generational quality 
loss such as we used to experience when dubbing tapes in an analog environment.

[ Go to top ] 

Adding Fonts

Lonnie Bell writes:

I have a client asking for a specific font which is not part of FCP5, LiveType, or Motion. So, 
how do i enlarge my font database... are there third party plugins that i can fully integrate 
with my FCP Studio Applications you can suggest, or do i need to bite a larger investment 
bullet and get Photoshop and all its glory... (even though photoshop is an eminent purchase, 
adding fonts is my quicker and cheaper fix!)

Larry replies: Not to panic! There are literally thousands of fonts you can add to your Macintosh. Keep in 
mind that Final Cut likes TrueType fonts. (There are also Postscript Type 1, Postscript Type 3, and 
OpenType font formats available as well. Stick with Truetype.)

I got bitten with the font bug many years ago when I worked for Bitstream and was introduced to world-
class type designers. Designing your own font that looks good is amazingly difficult. Buying a font that 
looks good is ridiculously easy. 

Here are some websites to check out, all offering high-quality typefaces. While cheap fonts are 
everywhere, these are some of the finest typefaces in the world. (Google lists millions more.)

http://www.datavideo.us/products/tbc_1000_main_page.htm


●     Adobe Type Library: http://store.adobe.com/type/index.html
●     Bitstream Type Library: http://www.bitstream.com/fonts/index.html
●     Linotype: http://www.linotype.com/
●     International Typeface Corporation: http://www.itcfonts.com/
●     Monotype Imaging: http://www.fonts.com/

Sacramento Added to Fall Power-Up with Final Cut Studio Tour

Thanks to the generous help of Torrey Loomis of Silverado Systems (http://www.silverado.cc/), we are 
adding Sacramento, California, to our Fall Seminar Tour: Power-Up with Final Cut Studio.

Based on your feedback, we've reworked the seminar contents to 
appeal to both beginning and experienced editors. And, thanks to the 
generous sponsorship of Blackmagic Design, we are adding sessions
that specifically address the high-end of HD and improving HDV workflows. 

The Power-Up Tour launches Sept. 21 & 22 in Sacramento and covers 13 cities across North America in 
ten weeks with two seminars in each city. A four-hour seminar to help editors who want to polish their 
editing skills, and a second seminar for those who want to push the boundaries of what they can do with 
Final Cut. 

Mark your calendars now. Early registration discounts end August 15. Seats are limited.

Click here to learn more, or register: www.larryjordan.biz/seminars

[ Go to top ] 

Timecode Tricks

Martin Baker, of Digital Heaven in the UK, wrote this on the Apple Trainer's Mailing List. I'm reprinting it 
here with his permission:

I was extolling the virtues of using the period character to denote 00 when entering 
timecodes today. So I got everyone in the class to type in the following:

01.50.

Assuming that this would locate to 01:00:50:00. Instead, a sea of bemused faces (including 
my own) watched as the playhead went to 01:01:50:00. Huh?! 

Answering my own question here I discovered I was missing something. This might be old 
news to everyone else but the shocking revelation for me was the period character does not 
represent "00", it just SEEMS that it does.

http://store.adobe.com/type/index.html
http://www.bitstream.com/fonts/index.html
http://www.linotype.com/
http://www.itcfonts.com/
http://www.fonts.com/
http://www.silverado.cc/
http://www.larryjordan.biz/sem/2006_fall.html
http://www.blackmagic-design.com/
http://www.larryjordan.biz/seminars


  
  
  
  
  
  
  
  
  
  

For example, assume the sequence starts at 01:00:00:00 and the playhead is positioned at 
the head.

When you type 4. that converts to 01:00:04:00 but the period actually represents the colon 
character. In fact you can type 4: and FCP will locate to the same timecode. FCP assumes 
the frames are 00 if there is no number following the period/colon.

Now add a number after the last period and you're specifying the frames:
Type 4.6 and the playhead goes to 01:00:04:06

Type 2.2.2 and the playhead goes to 01:02:02:02

Type 2... and the playhead goes to 02:00:00:00 (but not because the period represents 00 
even though it looks that way!)

So when I entered 01.50. I was actually entering 1 minute, 50 seconds, 0 frames rather than 
1 hour, 00 mins, 50 secs, 00 frames.

So now I just got to explain this to the students :-)

Larry replies: Thanks for letting me share this. By the way, Digital Heaven makes some great plug-ins for 
Final Cut. Take a look at: www.digital-heaven.co.uk.

[ Go to top ] 

Proper Video Levels, Redux

Jeff Abelson writes:

There's a FCP black-level question that's vexing me, and I'm hoping you can give me some 
insight. I've read the articles on your site about it, (click here to read them) but I have still 
have some confusion.

I've cut a documentary in FCP 4.5, shot on DVCam. I'm prepping it to take to an online 
facility to output to DigiBeta for delivery to PBS, who licensed the show. Aside from the PBS 
specs in general making my brain melt -- the one item I'm particularly unclear about is black 
levels.  The online facility took a look at my show (which looks great on my NTSC monitor), 
and told me that too many of my clips have black levels that are not at zero, and so before 
they do their output, I have to bring the blacks down in each clip to zero, which I've now 
done.  But the visual result on the NTSC monitor (and on dubs played on my TV), is that the 
image is WAY too dark/contrasty.

I also understand that the blacks on the DigiBeta need to be at 7.5, and that this will happen 
in the output process.   

My question is this:  is the image in the zero-black sequence the actual level of visual 
darkness we will see broadcast on PBS -- or will the zero to 7.5 conversion when going to 
DigiBeta brighten the image so it will look like it used to?   

http://www.digital-heaven.co.uk/
http://www.larryjordan.biz/articles/lj_white.html


In other words, is the 7.5 just another way of describing the same level of digital blackness in 
my zero-black sequence (meaning it will still look the same to the eye), or will they actually 
be brightening up the image on the DigiBeta?

If the latter, then I'll relax.  If the former, I'm worried.  And believe it or not, the online facility 
has not been able to adequately answer this question for me (I know, I should find another 
facility, but I'm just about out of time/money for this).

Larry replies: Jeff, ALL black levels for digital video are set to 0 in Final Cut -- this is the normal level for 
digital video black. So, your post house is correct.

Analog black for NTSC - US is 7.5 IRE. This is analog only. Your black levels will automatically change 
when dubbing from a digital device to an analog device. This is done either thru your capture card or at the 
output of your deck, whichever you use, so you don't need to worry about it.

The DigiBeta is a digital device. So send your sequences to it with blacks set to 0. When it creates an 
analog output, the Digi deck will automatically add the necessary setup to raise the black levels to 7.5 IRE.

If your images look too dark, I would suspect the monitor is not calibrated properly.
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Exporting Stills

Dick Osso wrote in with a question that has generated a LOT of responses: 

MY KINGDOM for a fix to this!!!!

I've got a problem that maybe you haven't been asked......

If I've recorded an event and from that video, I want to make 100 stills to put into some 
slideshow, I have to do the following steps:

1.  Find Image
2.  MODIFY
3.  Make Freeze Frame
4.  EFFECTS
5.  De-Interlace
6.  FILE
7.  EXPORT
8.  Using QT Conversion
9.  SAVE AS

10.  FORMAT
11.  Still Image
12.  SAVE

Larry, that's 12 key strokes.... times 100 images, or 1,200 key strokes! Help!



Larry replies: Dick, a faster way to create stills is to export your sequence as an image sequence. Here are 
the steps:

●     Cut your clips to the timeline -- keep them relatively short
●     Export the entire sequence as an image sequence
●     Select your images and edit in PhotoShop

To export as an image sequence:

●     File > Export > Quicktime Conversion
●     Give your sequence a name -- all the images will start with this name
●     Pick a location to store your images (a folder is a REAL good idea)
●     Change Format to Still Image
●     Pick an image format you like -- I prefer TIFF or PNG. PNG is the default. 
●     Click Save

This should be much quicker.

Update #1 : As I was writing this, Brian Taylor sent me a write-up of how he creates still frames of his 
video files. It's a one-page 65KB PDF file which you can download here. 

Update #2 
Just after publishing this newsletter, Nick Meyers, from Down Under, wrote in with a better idea:

Exporting as an image sequence is a nice bit of lateral thinking, but here's a more direct way 
-- use Batch Export.

Here are the steps:

●     Create a bin to store your freezes in the Browser
●     Open the clip you want to freeze in the timeline
●     Create a freeze frame (Shift+N)
●     Drag the freeze from the Viewer to the bin you created in the Browser
●     When you are done making freezes, select them all in the bin and choose File > Batch Export
●     Click Settings at the bottom of the window
●     Click Set Destination to set the destination folder on your hard disk
●     Set Format to Still Image
●     Set Settings to Default Settings
●     Click OK
●     Click Export at the bottom of the window
●     If you have a colon in your file name, you'll need to remove it prior to saving
●     Done.

Larry replies: Nick, this is a very slick, and much faster, workaround. Thanks.

[ Go to top ] 

http://www.larryjordan.biz/goodies/Thumbnails.pdf


Boosting Low Audio

Robert Rowe writes:

I had some audio that was recorded at a level so low that cranking up the traditional volume 
controls still wasn't giving me the loudness I required. In class last year, you taught me how 
to "stack" the audio clips by copying and pasting them in multiples to beef up the volume.  
Worked like a charm.
 
I don't want any credit.  I just wanted to give something back for all the help you gave me 
last year.

Larry replies: Robert, there's no harm in getting some credit. This is a nice technique. Thanks for writing.

[ Go to top ] 

Which Way to Render

Matthew London writes:

I've been looking all over your website, and in your FCP tutorials at Lynda.com (of which I 
am a subscriber) but I have not found a good explanation of which options I should have 
checked in my Render Selection or Render All menus in FCP (5.0.4 on 10.4.6). Of course 
when I am ready to output, I select everything, but I really don't understand how to get the 
maximum quality with the shortest time for preview short sections. Any suggestions or 
pointers would be highly appreciated.

Larry replies: The first rule of output is that everything must render before output. By default, FCP only 
renders clips with red bars over them. However, in general, I find that too limiting.

You can get fancy and just select a few colors to render, but I prefer to keep my life simple - I go to 
Sequence > Render Selection and check ALL the options. Then, I don't worry about it. Whenever you 
need to render something, select it and press Command+R.

[ Go to top ] 

Last Month's Poll

Last month, I wanted to find out what types of projects you were working on. Here are the results.



 

Clearly, documentary was the winner. But I was interested to see the wide range of other types of projects 
Final Cut Studio is used for.

Then, I noticed there were 32 "Other" comments. So, here are projects people are working on that I didn't 
even list.



 

Thanks for taking the time to vote. If you want to see the results of past surveys, click here. 

[ Go to top ] 

This Month's Poll

This month, I'm interested in learning more about how much you use Livetype and Motion -- and what you 
use them for.

Here's a simple one-screen survey that will help me figure out how to write about these two applications 
the future.

Click here to take the survey -- it should take about a minute -- and I'll share the results next month:

http://www.pollmonkey.com/p.asp?U=9058630216 

[ Go to top ] 

Reader Mail

I am TRULY grateful for all your messages and comments. I learn something with almost every letter. Keep 
on sending them and I'll share them with all of us. 

Color Correction in Mass Quantities

Emily Rumsey, from Madison, Wisconsin, writes:

http://www.larryjordan.biz/surveys.html
http://www.pollmonkey.com/p.asp?U=9058630216


I've got 30+ clips of the same (bad color) clip. How do i give them all the same color 
correction settings?? 

Larry replies: Easy. 

●     Color correct the first clip so it looks good.
●     Select all remaining clips.
●     Grab the hand from the color correction filter (at the top) and drag it on top of one of the selected 

clips.

Everything is now color corrected.

Here's an article that describes a simple process for color correction.

[ Go to top ] 

Don't Defrag your Hard Disk

Jay Babina writes:

I read your article on maintenance. But I can't get a clear answer from anyone. Does OS-X 
defrag itself or does it need periodic defraging from an outside application? Windows has a 
built in app for that, does OS-X? Or does UNIX systems need it less than the old System 9?

Larry replies: Don't defrag your hard disks when using Final Cut. It slows everything down. Let Final Cut 
capture and store your video files in its own way and leave them alone.

[ Go to top ] 

Green screen help needed

Chris MacDonald writes:

I am looking for a method of Keying-green screening that give me the alpha channel to 
export to Flash ( I need to use flash video in my projects). Right now I know I can composite 
but I need to green screen to alpha... I currently use AE 7 Pro with keylight is that my best 
option?

Larry replies: Chris, I have no idea. Let's see if any readers have suggestions. If so, I'll update this 
newsletter in a couple of days with their comments.

[ Go to top ] 

http://www.larryjordan.biz/articles/lj_color.html


XML Export

Christian Janson writes:

I took your class about 1 year ago. I recently took on a project where I had to out source the 
video editing. This worked great in freeing my time to handle other tasks but became a 
headache when I found that the editor was using a newer version of FCP. 5.0 or higher. My 
system is FCP 4.5.

We tried the XML feature but it resulted in frustration and failure. Surely the pro's have 
thought of this issue, yet I could not find any documentation dealing with any issue in saving 
to XML from 5.0. It was simply stated as fact. Did I do something wrong... or am I a victim of 
theory?

Larry replies: You don't SAVE to XML, you EXPORT to XML. (File > Export > XML...) I've only done this 
twice, moving from a later to an earlier version of FCP, but it worked well both times.

Here is an outline of the steps:

1.  Open your sequence in the Timeline
2.  File > Export > XML
3.  Accept the defaults in the XML dialog box
4.  Save the file
5.  Move the file to the other FCP system
6.  Select File > Import > XML
7.  Import your file

You may need to recapture the media, depending upon which versions of FCP are involved. You will 
definitely need to reconnect it. But all your project data will move across fine.

This process does NOT work if two people need to work on the same project at, essentially, the same time. 
XML export/import is designed as a one-time-only conversion, not a day-to-day working environment.

[ Go to top ] 

Recapturing video from a DVD

James Calhoun, an architect who uses FCP, writes:

I really appreciate your newsletters. Someday I hope to make a seminar! 

One thing that has me very frustrated - after making a movie and burning it to DVD, is there 
any way (in the MAC world) to recapture it back into the computer.

I have some early iMovie DVDs with no movie clip back ups left anymore that I would love to 
recapture off the DVD's into final cut.... is there a way? Criminal, in my opinion that this 
function is not possible...



Thanks for your good stuff.

Larry replies: No criminal intent here at all. Its entirely possible -- check out: http://www.dvdxdv.com.

They have some nice, simple utilities that do exactly what you are asking -- both for DV and HDV.

[ Go to top ] 

Final Cut Not Recognizing a Firewire Device

Stuart Math writes:

I use a Sony DVDirect VRDVC20 to burn screening DVDs. The unit works as both a DVD 
burner (PC only) and DVD recorder. It has FW, composite, and s-video inputs for video. It's 
a nice unit, it burns at three different data rates and encodes audio to AC3. It records the FW 
output from DV cameras but it doesn't recognize the FW output from FCP. 

Sony tech support is no help. I was wondering if you could explain in layman's terms the 
difference between the FW output from a DV camera and the FW output from FCP? 
Obviously there is some difference. When I connect the FW from my MAC to this unit, the 
burner doesn't see a video signal and FCP shows that the Apple FW NTSC is missing. What 
gives? Is this an FCP user error.

Larry replies: Stuart, not all Firewire devices use the same protocol. This device is not supported by Final 
Cut. I spent about an hour wandering Apple's website to find a list of supported devices to no avail. 
Fortunately, Mick Horton, over at the LA Final Cut Pro User group (www.lafcpug.org) sent me a supported 
device listing from Apple's website. It is current as of July 6, 2006. 

You can download the 112KB PDF file by clicking here. Zoom in, the text is microscopic! 

[ Go to top ] 

Making the Most of High-Resolution Stills

Philip Howe, from Australia, writes:

I've been editing since the days of film cement and losing frames each time you made a cut. 
I've kept up with technology as it has nearly always meant improvements in work flow and 
joy. I'm currently teaching a highly experienced photographer who works with the military 
here in a testing facility - he makes films and videos of his work using FCP and I have taught 
him over the years to be a very capable film maker. 

He's here now with footage and photos to build a new promo of his and their work - I've hit a 
snag that's bothering me because in the past I've managed pretty well with the issue that is 
causing strife; namely the fizzing of high resolution stills when viewed from the time-line from 

http://www.dvdxdv.com/
http://www.lafcpug.org/
http://www.larryjordan.biz/goodies/studio_qualified_06_07.pdf


FCP, on my Reference monitor.

I'm seeing a horizontal sizzling across the centre of the frame on aerials of the country 
beneath, where there are high contrast detail differences, and "strobing", as in fine vertical 
fizzing, on ground level stills where there are wires and thin pylons. I would usually reduce 
the size of the still by reducing the resolution from his usual 300 dpi to 150 or even 72 (if 
enlarging is not required) or I would reduce the resolution alone by un-ticking the Resample 
function (in Photoshop) but this is not working. It doesn't seem format specific either, he has 
large JPEGs and also uncompressed TIFFs - the fizzing is happening with both.
I've tried De-interlacing (interpolation or duplication - with Stibs, with JES and also with the 
more basic FCP De-interlace) and also De-flicker. All to no avail so far.

Would you have any thoughts? I've looked through your articles but can find nothing that 
solves this annoyance. I'd really like him to return to his facility a happy man!

Larry replies: Philip, you didn't mention which version of FCP you are using. FCP 5 introduced a whole new 
scaling algorithm with three different levels of quality. You can set it by making your Sequence active in the 
Timeline, then selecting Sequence > Settings > Video Processing tab. This only effects clips which are 
either rotated or scaled. 

Here are some things to consider:

●     Make sure all your stills are set to 72 dpi
●     Try to keep your total pixel dimensions smaller than 2,500 x 2,500. My preference is smaller than 

2,000
●     Thin lines will always tend to vibrate -- it's the nature of interlaced video.
●     Deinterlacing won't help -- the stills are deinterlaced already.
●     Adding a 0.5 Gaussian blur might help as well

Here's a recent article you can use for reference that might give you some more ideas.

[ Go to top ] 

Picking a Codec

Robert Sink, Philip Hodgetts and others asked:

Looking at your codec table from last month's newsletter, I am curious what criterion is being 
used for the Quality column, and how DVCPro-50 gets a higher ranking in quality than 
Uncompressed 8-bit.

I am doing a 16mm film-to-tape transfer to DigiBeta, then saving to file as uncompressed 8-
bit. My goal is as much latitude as possible for color correction purposes. The source film is 
1970's positive film stock of good to mediocre quality, so I felt 10-bit wasn't necessary.

I would love to use DVCPro-50 to take advantage of the space savings, but the format got 
mixed reviews at the wonderful Codec Resources Site: http://codecs.onerivermedia.com/

http://www.larryjordan.biz/articles/lj_grfx_look.html


Any suggestions as the best codec to use to focus on color correction?

Larry replies: Um, well, this was an error on my part. I rated DVCPro-50 as Very Good. However, it is only 
an 8-bit codec. On further reflection, I realized I should have rated it the same as Uncompressed 8-bit, 
both of which are Good.

Whenever image quality is critical, use the least compressed video format possible. Uncompressed 10-bit 
gives the best results, but it creates truly huge files. Uncompressed 8-bit is a good second choice, unless 
you are working with gradients, in which case 10-bit is better.

[ Go to top ] 

Working with Stills

David Scott writes:

For the past year or so, I've been creating seven-minute "slide shows" for a local non-profit. I 
shoot high res digital stills, then prepare them for FCP in Photoshop CS2. I double the size 
of every picture because I animate them (mostly zooms) a la Ken Burns and want to 
maintain optimum quality. Until FCP 5, I had little trouble with maintaining a photo's aspect 
ratio integrity. As per your book, page 320, an image cropped to 720x540x72 and imported 
into FCP 5 looks fine. However, when I double the size to 1440x1080x72, FCP squashes the 
image as it outputs it to my external Sony NTSC 4:3 monitor. I've tried resizing and changing 
pixel shape as per recommendations in a variety of other books but can never achieve an 
accurate image on the monitor. As I experiment, images are either squashed or too thin, 
depending on whose advice I follow. Frankly, advice from book to book is not consistent. 
This is driving me nuts!

Larry replies: David, I ran into the same problem and it drove me nuts. Here's the answer: 1440 x 1080 is 
the size of an HDV frame. FCP thinks you are importing an HDV still, and treats it accordingly. It is NOT 
easy to convince FCP this is not an HDV frame.

So, create your stills at 1800 x 1350 x 72 and everything will be fine.

David replies, again: 

I found another workaround, I simply crop to 720x540x144 (doubling the dpi rather than the 
image dimensions). While I've always understood both approaches are the same thing as far 
as the TIF is concerned, the second yields both a perfect FCP Viewer image upon which to 
work as well as an identical perfectly proportioned image output to my NTSC monitor. 

Whoa! I just discovered http://www.larryjordan.biz/articles/lj_fcp5_stills.html on your web 
site. It specifically addresses the very problem that has been vexing me since FCP 5. 
However, I'm curious as to why my solution - cropping to 720x540x144 - is a simple 
alternative to the 1800x1350x72 you suggest. Mine seems to perfectly fill the FCP 5 frame 
and looks terrific on my NTSC monitor.

Larry replies: David, apparently, FCP 5 is reading the 144 dpi as an image file, rather than counting total 
pixel dimensions. An HDV image is only 72 dip. If your workflow works, use it. However, I would shift to 



1800 x 1350 to avoid any possible confusion with an HDV frame.

[ Go to top ] 

It's a Capital Idea

Jacob Hodgman, of the South Australia Police Academy, writes:

I have seen references to DV having a 25 Mbs bandwidth – most recently in your June 
newsletter (Reader mail, Uli Plank). The obvious question here is why do we only get 3.75 
Mbs of data when capturing DV into FCP, if DV can (apparently) handle more?

Is my terminology around the wrong way? Does bandwidth mean something different as 
opposed to data captured?

Larry replies: It all in that letter "B."

Bandwidth is measured in megabits per second (Mbps); while data rates are measured in megabytes per 
second (MBps). (Notice the small vs. large B).

A megabyte is 8 times larger than a megabit. So 25 Mbps equals 25/8 megabytes or 3.125 MBps. Then, 
you add the audio data rate to arrive at the standard data rate for DV video of 3.75 megabytes per second 
(MBps).

[ Go to top ] 

Exporting HDV to H.264

Dan Weber writes:

Love the newsletter. This month (June) you had a short example sent in on how to export 
H.264 clips from HDV (1080i) timelines in FCP.

I have been doing this for the past year using footage shot with my Z1. I have found that the 
best way to get real good H.264 clips is to convert the content to progressive format before 
you make your H.264 movie.

I edit my piece, mark in and out at the start and end, then I export a Quicktime move using 
the DVCProHD 720p60 setting.

I then load this new clip into Compressor, where I then make the H.264 file. If you have clips 
with lots of motion, they look better this way then going directly from the FCP timeline.

Larry replies: Cool. Thanks.



[ Go to top ] 

No Subject Too Small

Following up on last month's discussion of it's vs its, Ben Balser writes:

My mother was a school teacher, two masters degrees, school administrator, etc. I'm from a 
very long line of professional educators. So when I began writing a long time ago, my mom 
tutored me in proper technical writing (she used to teach it at a local university). 

The subject if "its" vs "it's" gets confused very often. Technically, you can use either. "It's" 
can be used as a contraction or as possession. "Its" can only be used as a contraction and 
not as possession. So the way you used it is perfectly legal according to the rules of writing.

But there are some who get the rules bent way out of proportion and think "it's" can't be used 
as contraction, or can only be used as contraction. Even college literature teachers (who my 
mom used to correct very often).

Larry replies: Thank you for your comments. I find them reassuring.

[ Go to top ] 

Wrap-up

Well, that wraps it up for this issue. We've got some exciting stuff planned for the next few months -- 
including some new training DVDs coming out shortly -- and I'm looking forward to telling you about all of it.

Please register for one of our seminars - early registration discounts end August 15.

If you a are looking for ways to optimize, or troubleshoot, your system, buy our latest DVD. 
Click here to visit our store. 

Finally, remember to share your opinions in our monthly poll. Click here to vote: http://www.
pollmonkey.com/p.asp?U=9058630216.

I'm grateful for all your comments and questions. I love hearing from you because when you share your 
ideas and suggestions, we all learn.

Thanks and edit well.

Larry

http://www.larryjordan.biz/sem/2006_fall.html
http://www.larryjordan.biz/store/index.html
http://www.pollmonkey.com/p.asp?U=9058630216
http://www.pollmonkey.com/p.asp?U=9058630216
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up at www.
larryjordan.biz.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not sold, rented, or 
bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. However, due to the 
variety of possible system and software configurations, the author assumes no liability in case things go 
wrong. Please use your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has not been 
reviewed or sanctioned by Apple or any other third party. All trademarks are the property of their respective 
owners and are mentioned here for editorial purposes only.

Text copyright 2006 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter may not be 
reproduced or published in any way, in whole or in part, without specific written permission from the author. 

Links to my website home page or articles are welcome and don't require prior permission. 
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